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Linear Elastic 

Analysis of a 

Spanner 

For LUSAS version: 19.0 

For software product(s):  All (except LT versions) 

With product option(s): None. 

Description 

A linear static analysis is to 

be carried out on the spanner 

shown. 

The spanner is supported as 

though it were being used to 

turn a nut, and is loaded with 

a constant pressure load 

along the top edge of the 

handle. 

Units used are N, mm, t, s, C, throughout. 

Keywords 

2D, Inplane, Plane stress, Linear, Elastic, Regular Meshing, Irregular Meshing, 

Copy, Rotate, Mirror, Transformation, Groups, Deformed Shape, Contour Plot, 

Principal Stress Vector Plot, Graph Plotting, Slice Section Results. 
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Objectives 

The required output from the analysis is: 

 A plot of the deformed shape. 

 A plot of the equivalent stresses in the spanner. 

 A graph showing the variation in equivalent stress where the handle meets the 

jaws. 
  

Associated Files 

 spanner_modelling.vbs  carries out the modelling of the example. 
 
 

Modelling : Features 

This section covers the definition of the features (Points, Lines and Surfaces) which 

together form the geometry of the spanner. 

 The symmetry of the spanner will be used by firstly defining one half and then 

mirroring about a horizontal centre-line. 

 One half of the jaws will be defined by three Surfaces using 3 different methods. 

One Surface will be defined simply by its bounding coordinates, a second by 

sweeping a Line through a rotational transformation and a third by copying the 

second Surface using a pre-defined rotation. 

 One half of the handle will be defined using one Surface. It will be bounded by 

three Lines, one of which will be a cubic spline. 

 Once the Surfaces have been defined, they will all be mirrored about the spanner 

centre-line. 

 The features which make up the spanner will be divided into two Groups, the 

jaws and the handle, to make the assignment of attributes easier.  
 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller, see the heading Running LUSAS Modeller 

in the Introduction to LUSAS Worked Examples document. 

Note. This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command 

File>New to start a new model file. Modeller will prompt for any unsaved data and 

display the New Model dialog. 




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Creating a new model 

 Enter a File name of 

Spanner 

 Use the default User-

defined working 

folder. 

 Ensure an Analysis 

type of Structural is 

set. 

 Select an Analysis 

Category of 2D 

Inplane 

 Set Model units of 

N,mm,t,s,C 

 Leave the Timescale units as Seconds 

 Select a Startup template of 2D Plane Stress.  

 Ensure the Layout grid is set as None 

 Enter a Title of spanner  

 Click the OK button. 

The Attributes  treeview will be populated with potentially useful basic line mesh, 

geometric and support entries appropriate to the settings made on the new model dialog. 

Note.  The Undo button  may be used to correct a mistake. The undo button 

allows any number of actions since the last save to be undone. 

Modelling geometry 

LUSAS Modeller is a feature-based modelling system. The model geometry is defined 

in terms of features (Points, Lines, Surfaces and Volumes) which are later meshed to 

generate the Finite Element Model ready for solution. The features form a hierarchy, 

with Points defining Lines, Lines defining Surfaces and Surfaces defining Volumes. 

 

 

 


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 Enter coordinates of (0, 20), 

(-20, 20), (-20, 30) and (0, 40) to define 

the vertices of the Surface.  

Note. Sets of coordinates are separated 

by commas or spaces. The Tab key is 

used to create new entry fields. The arrow 

keys are used to move between entries. 

 Click the OK button to make the 

dialog disappear and generate the 

Surface as shown.  

Note. If the Z ordinate is omitted zero is 

assumed. 

Note. Confirmation that the Surface has 

been created is given in the message 

window. 

Note. Cartesian, cylindrical or spherical coordinates systems may be used to define 

models. In this example Cartesian coordinates will be used throughout. 

The right-hand vertical Line will be used to create a Surface by sweeping the line 

through a rotation of 45 degrees clockwise. 

 Select the Line by 

moving the cursor over 

the Line shown and 

clicking the left-hand 

mouse button.  

The line will change colour to 

show it has been selected. 

Note. Feedback on the items 

currently selected is provided on 

the right-hand side of  the status 

bar at the bottom of the display. 

 

 

 

Geometry 

Surface > 

By Coords... 

 









Select this Line

... and sweep it to

form this Surface

 


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 Select the Rotate option and 

enter -45 for the angle of rotation 

about the Z-axis.  

 

 Enter the attribute name as  

Rotate 45 Clockwise 

 Click the Save button to save 

the dataset for re-use later. 

 Click the OK button to sweep 

the Line clockwise through 45 

degrees about (0,0,0) to create 

a Surface. 

Note. Clockwise angles are 

negative and anti-clockwise angles 

are positive.  

The Surface just drawn will now be 

copied by rotating it through a 45 

degree rotation clockwise. 

 Select the previously 

drawn Surface by clicking 

on it with the left-hand 

mouse button. 

 

 

 

 

 

 

 

 

Geometry 

Surface > 

By Sweeping.. 

 



Select and copy

this Surface

To form this Surface
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 Select the attribute Rotate 45 

Clockwise from the drop down list. 

 Ensure that the number of 

copies is set to 1 

 Click the OK button to copy 

the Surface, rotating it 

clockwise through 45 degrees. 

 

 

 

 

 

To define the top line of the handle of the spanner a cubic spline will be created. 

Note. A cubic spline is a Line which passes through any number of Points. If required, 

the start and finish directions of the spline can be defined by specifying end-tangents 

(i.e. by specifying the directions of Lines at its ends).  

In this example end-tangents are used to fix the start and finish directions of the spline 

so a construction Line must first be defined.  

 Enter coordinates of (200, 0) and (200, -10) 

to define the construction Line. 

 Click the OK button to generate a vertical 

Line away from the existing Surfaces. 

This Line will be used to specify the finishing 

direction of the cubic spline. 

Note. When selecting features to define a cubic 

spline it is very important that the correct features 

are selected in a particular order. The Lines that 

define the start and finish directions of the spline 

are to be selected first, followed by the Points that 

define the start and end positions of the spline. 

 

Geometry 

Surface > 

Copy... 



Geometry 

Line > 

By Coords... 

 


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Defining a cubic spline 

 Select the arc shown 

by moving the mouse 

over the arc and click 

the left-hand mouse 

button. (This arc 

defines the direction 

in which the spline 

starts). 

 Hold the Shift key 

down to add additional features to the selection  

 Select the construction Line defined earlier by moving the mouse over the Line 

shown and click the left-hand mouse button. (This Line defines the direction in 

which the spline ends). 

 Continue holding the Shift key down to further add to the selection. Select the 

Point on the end of the first arc selected. (This defines where the spline starts). 

 Still holding the Shift key down, select the Point on the end of the construction 

Line. (This defines where the spline ends). 

 Click the OK button to generate a default cubic spline to form the handle of the 

spanner, ensuring that both reverse options are off. 

 

Note. Line directions can be seen by double-clicking on the Geometry entry in the  

Treeview and selecting the Line directions check box. 

Once the spline is drawn correctly the construction Line is deleted. 

 Drag a box 

around the 

construction Line 

by firstly moving 

the mouse above 

and to the left of 

the Line.  

 Click the left-

hand mouse button and holding it down move the mouse to the right and down 

so that a box is shown which completely encloses the Line as shown. Release the 

left-hand mouse button. LUSAS will highlight the selected features. 

4. Select this Point

1. Select this arc

2. Select this Line

3. Select this Point

 

Geometry 

Line > 

Spline > 

Tangent to 
Lines... 



Drag a box around the construction Line
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 Delete the selected features. 

 Click the Yes To All button to delete the selected Line and Points 

Note. The Delete key can also be used to delete features. For a full list of keyboard 

shortcuts refer to the Online Help file, which can be accessed from the Help > Help 

Topics menu. 

The centre-line of the spanner can now be defined by joining the two unconnected 

points into a Line. 

 Drag a box 

around the two 

Points on the 

centre-line of the 

spanner as shown 

 

 A Line will be drawn between the points selected. 

The Surface forming the handle of the spanner will now be defined by selecting the 

three Lines bounding the Surface. 

 Select the 3 Lines 

which define the 

Surface of the 

handle in the order 

shown, ensuring 

the Shift key is 

held down to keep 

adding to the 

selection. 

 If prompted, press OK to draw the Surface formed by the 3 lines selected. 

Note. Selecting the Lines in this anti-clockwise order ensures that the local element 

axes of the Surface will be suitable for the applied face loading that will be applied later 

in the example. Selecting the Lines by dragging a box around them would not 

necessarily produce the same Surface axes. 

Mirroring model information 

Half of the model has now been defined. This half can now be mirrored to create the 

whole model. The first step in the process is to define a mirror plane. 

Edit 

Delete 



Drag a box around these 2 Points
 

Geometry 

Line > 

By Points... 

1. Select this Line

2. Hold Shift key down

3. With Shift key

down select this Line

4. With Shift key

down select this Line
 

Geometry 

Surface > 

Lines... 


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 Select the 2 points 

shown, making sure 

the Shift key is held 

down in order to add 

the second Point to 

the initial selection. 

These Points define the axis 

about which the spanner 

will be mirrored.  

Places the Points selected into memory. 

 

Next, the Surfaces to be mirrored are to be selected. This will require the whole model 

to be selected.  

 Select the whole model by dragging a box around the features 

Note. An alternative to dragging a box around all the features to select them is to 

press the Ctrl and A keys at the same time. 

  Select Mirror – from Point 14 

and Point 15 from the drop down list 

and click the Use button on the 

dialog to use the points previously 

stored in memory. 

 Click the OK button to copy 

all of the Surfaces, mirroring 

them about the centre-line to 

give the model shown in the 

previous diagram. 

If the model features have been 

mirrored successfully the Points held 

in memory may be cleared. 

The Points are now cleared from 

memory. 

Note. Right-clicking on the view with geometry selected opens a menu with shortcuts 

to Delete, Move, Copy and Sweep. 

This has completed the spanner geometry. 

1. Select this Point

2. Hold the Shift key down

3. Select this Point
 

Edit 

Selection Memory > 

Set 



Geometry 

Surface > 

Copy… 

 

Edit 

Selection Memory > 

Clear 


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Using Groups 

Tip. Model features can be grouped together to make assignment and viewing of 

model attributes easier.  

In this example the Surfaces defining the jaws of the spanner will form one Group. The 

Surfaces defining the handle of the spanner will form another Group. 

 Drag a box around 

the Surfaces 

representing the 

jaws of the spanner.  

 This adds a New 

Group entry to the  

Treeview for the features 

selected.  

 

 

 Enter the group name as Jaws and click OK to finish defining the group.  

 

 Drag a box 

around the 

Surfaces 

representing the 

handle of the 

spanner. 

 This adds a New 

Group entry to the 

Treeview for the 

features selected.  

 

 Enter the group name as Handle and click OK to finish defining the group. 



Drag a box to select

the Jaw features

 

Geometry 

Group > 

New Group 

Drag a box to select the Handle features
 

Geometry 

Group > 

New Group 
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Modelling features recap 

The features that form the 2-Dimensional representation of the spanner have been 

defined.  In this section the following topics have been covered: 

 How to define Points, Lines and Surfaces. 

 How to define Lines by specifying the coordinates of their Points and by joining 

existing Points.  

 How to define Surfaces by their bounding coordinates, by sweeping, and by 

copying. 

 How to define a cubic spline. 

 How to select features by using the Shift Key to add to a previous selection. 

 How to select features by dragging a box around features to be selected. 

 How to select all features in a model by pressing the Control and A keys. 

 How to rotate and mirror model features. 

 How to define groups of features. 

Modelling : Attributes 

The Attributes  treeview will be initially populated with useful basic line mesh, 

geometric and support entries appropriate to the settings made on the new model dialog. 

Where applicable these can be assigned directly to selected features in a model, or be 

edited as required. Otherwise, specific attributes will need to be defined.  

For this example the following attributes need to be defined: 

 The finite element mesh to be used. 

 The thickness of the spanner. 

 The material from which the spanner is made. 

 The supports to be used. 

 The loading on the spanner. 
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Defining and assigning model attributes 

Note. LUSAS Modeller works on a 

define and assign basis where 

attributes are first defined, then 

assigned to features of the model. 

This can be done either in a step-by-

step fashion for each attribute or by 

defining all attributes first and then 

assigning all, in turn, to the model.  

 Attributes are first defined and 

are subsequently displayed in 

the  Treeview as shown.  

Unassigned attributes appear 

‘greyed-out’. Assigned 

attributes appear 'coloured'. 

 Attributes are then assigned to 

features by dragging an 

attribute dataset from the 

Treeview onto previously 

selected features. 
  
 

Tip. Useful commands relating to 

the manipulation of attributes can be 

accessed by selecting an attribute in 

the  Treeview, then clicking the 

right-hand mouse button to display a 

shortcut menu. 

Defining the mesh 

The spanner will be meshed using both regular and irregular Surface meshes. A regular 

mesh is to be used for the jaws of the spanner. An irregular mesh will be used for the 

handle.  

The number of elements in the regular Surface mesh will be controlled by defining line 

meshes on the Lines defining the boundary of the Surfaces. The number of elements in 

the irregular Surface mesh will be controlled by specifying an ideal element size. Other 

methods of controlling mesh density are also available. 



 


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Defining a regular surface mesh 

 Select Plane stress 

elements, which are 

Quadrilateral in shape 

with a Quadratic 

interpolation order.  

 Ensure that the Regular 

Mesh button is selected 

and Allow transition 

pattern is not selected. 

 Enter the attribute name 

as Regular Plane 

Stress 

 Click the OK button to 

add the Surface mesh 

dataset to the  

Treeview. 

The mesh will be assigned to the model at a later stage. 

Controlling mesh density 

The lines currently defined have 4 divisions per line by default, but in this example only 

2 divisions are required for the Lines defining the jaws. This can be done by either 

changing the default number of divisions per Line or by making use of Line mesh 

attributes. In this example, the default number of divisions will be changed. 

 Select the Meshing tab and set the Default Line divisions to 2. 

 Click the OK button. 

Attributes 

Mesh > 

Surface… 

 

File 

Model Properties… 
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Defining an irregular surface mesh 

 Select Plane stress, 

Triangle, Quadratic 

elements. 

 Select the Irregular 

mesh button.  

 Select Element Size 

and then specify an 

element size of 18. 

(This defines the 

maximum side length 

of the elements on the 

lines defining the 

perimeter of the 

spanner.) 

 Enter the attribute 

name as Irregular 

Plane Stress.  

 Click the OK button to add the Surface mesh attribute to the Treeview. 

The mesh will be assigned to the model at a later stage. 

Defining the thickness 

So far the spanner has been defined in two dimensions. In order to give the spanner its 

thickness geometry attributes will be used. The jaws of the spanner are 15mm thick 

whilst the handle is 10mm thick. Two geometry attributes are required. 

 Enter the thickness as 15.  

 Enter the Attribute name 

as Thickness=15 

 Click the Apply button to 

add the geometry 

attribute to the  

Treeview. 

 

 

Attributes 

Mesh > 

Surface… 

 

Attributes 

Geometric > 

Surface… 
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Note. The Apply button allows information for another attribute to be entered using 

the same dialog. 

 Change the thickness to 10 

 Change the attribute name to Thickness=10 and click the OK button to add the 

additional geometry attribute to the  Treeview. 

Assigning a surface mesh and thickness to the jaws 

The Surface mesh and geometry attributes defined previously can now be assigned to 

the relevant features of the spanner. As an alternative to selecting features by dragging a 

box around them, the previously named Groups can be used. 

 In the  Treeview, click the right-hand mouse button on the group name Jaws 

and select the Select Members option from the menu. If you already have some 

features selected click Yes to deselect them first. 

 Drag and drop the Surface 

mesh attribute Regular 

Plane Stress from the 

Treeview onto the selected 

Surfaces. Modeller will 

confirm the mesh 

assignment for each Surface 

in the text window. 

The element mesh for the jaws of the spanner will be drawn. 

 Drag and drop the Surface geometry attribute Thickness=15 from the  

Treeview onto the selected Surfaces. The elements of the jaws remain selected. 

 Click the left-hand mouse button in a blank part of the View Window to deselect 

any previously selected model features. This shows that the geometric 

assignment has been visualised by default. 

Assigning surface mesh and thickness to the handle 

 In the  Treeview, click the right-hand mouse button on the Group name 

Handle and select the Select Members option from the menu.  

All Surfaces forming the group Handle will be selected. 

 Drag and drop the Surface mesh attribute Irregular Plane Stress from the  

Treeview onto the selected Surfaces defining the Handle. 


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LUSAS will draw the 

irregular element mesh for 

the handle of the spanner. 

Note. The text output 

window will show messages 

relating to the radius of 

curvature for two of the 

elements created. These can 

be ignored for this example. 

 Drag and drop the Surface geometry attribute Thickness=10 from the  

Treeview onto the selected Surfaces. Again confirmation of the assignment is 

provided in the text window. 

 Click the left-hand mouse button in a blank part of the View Window to deselect 

any previously selected model features. 

Assigning the material 

The material required for this example is provided by default when using the startup 

templates specified when creating the model. 

 Right-hand click the material attribute Steel (Mild Steel | Steel - Structural) 

from the  Treeview and select Assign to all to apply the mild steel attribute to 

the whole model. 

Visualising model attributes 

Note. Any attributes (i.e. geometry, material, supports etc.) assigned to the model can 

be checked visually to ensure that the correct item has been assigned to the correct part 

of the model. For example: 

 Click the left-hand mouse button in a blank part of the View Window to deselect 

any previously selected model features. 

 In the  Treeview, click the right-hand mouse button on the Thickness=15 

material attribute name and select the Visualise Assignments option from the 

dialog. 

 




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All features to which the 

Thickness=15 attribute is 

assigned will be visualised. 

 To turn-off the 

visualisation of the 

assignments, click the 

right-hand mouse 

button on the 

Thickness=15 material attribute name in the  Treeview and select the 

Visualise Assignments option again from the dialog. 

Note. This method can be used at any time during this example to check that selected 

attributes have been correctly assigned to the model. 

Manipulating layers 

At any time the layers displayed in the  Treeview may be re-ordered, hidden, 

removed or be re-added. 

 Select the Mesh entry in the  Treeview and drag it down to sit beneath the 

Geometry entry. In the view window the mesh can now be seen drawn on top of 

the geometry. 

 Click the right-hand mouse button on the Mesh entry in the  Treeview and 

select the On/Off option. The mesh will be hidden from the display. 

Fleshing  

Visualisation of assigned geometric attributes can also be seen using the fleshing 

option. 

 Select the fleshing 

on/off button to turn-on 

geometric property 

visualisation. 

 Select the isometric 

button to see the geometric 

visualisation on the elements.  

 Select the dynamic 

rotate button to view the 

spanner from the side. The 

 


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difference in thickness between the handle and the jaws can be seen. 

 Select the fleshing on/off button to turn-off the geometric visualisation. 

 Select the Home button to return the model to the default view. 

 Reset to normal cursor mode. 

Supports 

When using one of the standard startup templates, LUSAS provides the more common 

types of support by default. These can be seen in the  Treeview. Two support 

attributes are required, one which restrains movement in the X direction, and one which 

restrains movement in the Y direction.  

Assigning the supports 

 Select the Point on the 

centreline of the 

spanner as shown to 

assign the support 

Fixed in X. 

 Drag and drop the 

support attribute 

Fixed in X from the 

Treeview onto the 

selected point.  

 Click the OK button to assign the support to the Point selected for all the 

loadcases in analysis 1.  

The support will be visualised using an arrow symbol. 

 Select the 2 Points shown to assign the support Fixed in Y. Hold the Shift key 

down to add the second point to the initial selection. 

 Drag and drop the support attribute Fixed in Y onto the selected points.  

 Click the OK button to assign the support to the points selected.  

 The supports will be visualised using arrow symbols. 

 Click the left-hand mouse button in a blank part of the view window to deselect 

any previously selected model features. 

Select this Point for support

'Fixed in X'

Select these 2 Points for support 'Fixed in Y'
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Defining the loading 

A pressure load is to be distributed evenly along the top edge of the handle. 

 Select the Face option and click Next 

 

 On the Face loading dialog enter a load of 0.1 in the y direction. 

 Enter the attribute name as Face Load of 0.1.  

 Click the Finish button to add the loading attribute to the Treeview. 

 

 

Attributes 

Loading… > 
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Assigning the loading 

 Select the Line on 

the top edge of the 

spanner handle. 

 Drag and drop the 

loading attribute 

Face Load of 0.1 

from the  

Treeview onto the 

selected Line.  

 Click the OK 

button to assign 

the loading to the 

Line selected.  

 

 

 

 

Note. If the loading is displayed in the opposite direction to that shown the Surface 

forming the top half of the handle may be reversed as follows: 

 Select the Surface defining the top-half of the spanner by dragging a box around 

it. 

This will reverse the Surface axes and hence the direction of the loading.  

 

Saving the model 

 To save the model file. 

Modelling attributes recap 

In this section, the attributes of the model were defined and assigned to the features. 

 A regular Surface mesh with quadrilateral plane stress elements was defined and 

assigned to the jaws of the spanner. An irregular Surface mesh with triangular 

Select this Line

 

 



Geometry 

Surface > 

Reverse... 

File 

Save 
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plane stress elements and a fixed element size was defined and assigned to the 

handle of the spanner. 

 Two geometry attributes were used to specify the spanner jaws and handle 

thickness. 

 A material attribute specifying the properties of steel was assigned to all 

Surfaces. 

 Two support attributes were assigned in order to simulate the spanner being used 

to turn a nut and a structural face load was applied to the top edge of the handle. 

 Attributes assigned to the model were checked visually for correct assignment. 
  
The model definition is now complete. The next step in the process is to run an analysis 

to solve the problem. 

Running the Analysis 

 Open the Solve Now dialog and press OK to run the analysis. 

If the analysis is successful... 

Analysis loadcase results are added to the  Treeview.  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 spanner.out  this output file contains details of model data, assigned 

attributes and selected statistics of the analysis. 

 spanner.mys  this is the LUSAS results file which is loaded automatically 

into the  Treeview to allow results processing to take place. 

 

If the analysis fails... 

If the analysis fails, information relating to the nature of the error encountered can be 

written to an output file in addition to the text output window.  Any errors listed in the 

text output window should be corrected in LUSAS Modeller before saving the model 

and re-running the analysis. Note that a common mistake made when using LUSAS 

Modeller for the first time is to forget to assign particular attribute data (geometry, 

mesh, supports, loading etc.) to the model.  


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Rebuilding a Model  

If errors are listed that for some reason cannot be corrected, a file is provided to re-

create the model information correctly, allowing a subsequent analysis to be run 

successfully. 

 spanner_modelling.vbs  carries out the modelling of the example. 
 
 

 Start a new model file. If an existing model is open, Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as spanner 

To recreate the model, select the file spanner_modelling.vbs located in the \<LUSAS 

Installation Folder>\Examples\Modeller
 
directory. 

 

 Solve the model to generate the results. 

 

Viewing the Results  

In this section the results produced by the analysis of the spanner will be viewed. There 

are a number of ways to do this in LUSAS, allowing you to choose the most appropriate 

way to present your results. For this example: 

 A plot of the deformed mesh will be displayed and superimposed upon the 

undeformed shape for comparison. 

 The principal stress vectors will be plotted. 

 The von Mises stress contours for averaged stress values will be displayed. 

 Peak values of von Mises stress will be marked. 

 A graph will be produced showing the variation of stress along a slice section 

through the handle of the spanner. 
 



File 

New… 

File 

Script > 

Run Script... 
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Selecting the results to be viewed 

Analysis loadcase results are present in the  

Treeview inside the Analysis 1 entry as 

signified by the results bitmap . 

 

 

 

 

 

Deformed mesh plot 

To plot a deformed mesh the Geometry and Attribute layers will be hidden, the Mesh 

layer will be turned on, and the Deformed mesh layer will be added to the  Treeview. 

 Click the right-hand mouse button on the Geometry entry in the  Treeview 

and select the On/Off option. The geometry will be hidden from the display. 

 Repeat to turn off the display of the Attributes layer. 

 Repeat to turn on the Mesh layer. 

 Double click on the Mesh layer in the  Treeview to display the mesh layer 

properties. 

The mesh layer is to be plotted in green. 

 

 Select  and a dialog will appear 

showing the range of pens and colours in use.  

The mesh is currently drawn in a solid grey line style 

and is shown by the button with dashed outline. 

  

 Select the Green line pen. 

 Click OK to redraw the mesh in the new colour. 

 Double click on the Deformed mesh layer in the  Treeview to display the 

deformed mesh layer properties. 
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 Click the OK button 

to select the defaults 

and display the 

deformed mesh. 

 

 

 

Principal stress vector plots 

Principal stresses can be plotted as vectors with different colours being used to signify 

tension and compression.  

The mesh layer is no longer required and it will now be hidden. 

 Click the right-hand mouse button on the Mesh entry in the  Treeview and 

select the On/Off option. 

 Click the right-hand mouse button in a blank part of the view window and select 

the Vectors option to add the vectors layer to the  Treeview. 

The vector properties dialog will be displayed. 

 Select Stress vector 

results of Principal 

stresses from the entity 

drop down list.  

 Click the OK button to 

display the vector plot 

with tension vectors 

shown in red and 

compression vectors 

shown in blue. 
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Creating new view windows 

As an alternative to hiding, adding or removing layers from the  Treeview for each 

type of results to be displayed in a single view window, multiple view windows can be 

defined. New views can be created using default settings, or existing views can be 

saved before being applied to new views.  

This creates a new view window with default view layers of Mesh, Geometry, and 

Attributes. In the  Treeview, a new folder for spanner.mdl Window 2 will appear. 

 In the Window 2 folder in the  Treeview, turn-off the Geometry, Attributes 

and Deformed mesh layers 

 In the  Treeview, Loadcase 1 will be set active by default. 

Using page layout mode 

The model was created using a Working Mode view which allows a model of any size 

to be created. Results could be viewed using this mode of operation, but in order to 

allow additional information to be added without obscuring the model, Page Layout 

Mode can be used instead. 

The view window will resize to show the model view fitted on a piece of paper. 

 

 

 

 

 

 

 

Window 

New Window 

View 

Page Layout 
Mode... 
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 Ensure that the Landscape option 

is selected and that left, right, top 

and bottom page Margins of 60, 

10, 10, 10 respectively are set. 

 Click the OK button. 

 

 

 

 

 

 

 

 

Von Mises stress contour plot 

Contours of von Mises Stress (Equivalent Stress) may be plotted as lines or as colour-

filled contour ranges. To display stress contours the contour layer needs to be added to 

the  Treeview. 

 With no features selected, click the right-hand mouse button in a blank part of 

the active window and select the Contours option to add the contours layer to 

the  Treeview. 

The contour plot properties dialog will be displayed. 

 Ensure that Stress contour results 

are selected from the Entity drop 

down list, equivalent stresses SE 

from the Component list, and 

Averaged nodal are selected from 

the Display list. 

 On the same dialog select the 

Contour Display tab and ensure 

that the Contour key button is 

selected. 

File 

Page Setup... 
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 Click the OK button to display the contour plot of equivalent stress along with 

the contour key. 

Re-ordering layers in the Treeview 

The order of the layers in the 

 Treeview governs the 

order in which the layers are 

displayed.  

To see the mesh layer on top 

of the contours the mesh 

layer must be moved down 

the  Treeview list to a 

position after the contour layer. 

 In the  Treeview select the Mesh layer within Window 2, and drag and drop 

the Mesh layer name on top of the contour layer name. The mesh layer name will 

then follow the contour name and the mesh itself will then be displayed on top of 

the contour layer.  

Note. This ordering of layer names can also be done using the right-hand mouse 

button and selecting the Move Down option from the context menu presented.  

Moving the contour key and setting significant figures 

 In the  Treeview double-click Contours 

to open the properties dialog. 

 Select the Contour Display tab and press 

the Details button next to the Contour 

key option. 

 Set the X position to 125mm From left of 

paper, and the Y position to 10mm From 

top of paper. 

 Limit the Significant figures to 4 and press 

OK to return to the contour properties 

dialog. 

 Press OK to save changes and see the 

contour key position centrally near the top 

of the page. 

 



 



Linear Elastic Analysis of a Spanner 

 28 

Note. The contour key can also be moved (more easily) graphically by selecting any 

text or contour key colouring and dragging the key to a new position. 

Marking peak values 

 With no features selected click the right-hand mouse button in a blank part of the 

view window and select the Values option to add the values layer to the 

Treeview. 

The values properties dialog will be displayed. 

 Ensure Stress contour results 

from the Entity drop down list, 

equivalent stresses SE from the 

Component list, and Averaged 

nodal from the Location list are 

selected. 

 On the same dialog, select the 

Values Display tab and set 

Maxima values to display the 

top 1% of results. (This will 

show the peak stress value) 

 Click the OK button to add the peak values to the contour plot. 

 Use the Zoom in button 

to enlarge the view of the 

spanner to check the number 

obtained. 

 Press the Resize button 

to fit the model to the full 

view window. 

Saving view windows 

View layers and settings defined for a view can be saved for use with other view 

windows and for use within reports. 

 Accept the default settings presented and press the OK button to create a Saved 

view entry  ‘View 1’ in the Utilities  treeview. 

To update a view with the settings from a saved view: 

 Create a New Window using the Window > New Window main menu item. 



 

 

Window 

Save View 
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 Click on the Utilities  treeview and drag and drop the Saved view entry  

for View1 onto the newly created view window.  This updates the newly created 

view to show those layers and settings saved with View 1.  

Note. It is very useful to name a saved view with a name that reflects the contents of 

the view. For example, saved view names of ‘Contours of SE’, or ‘Maximum 

displacement, or ‘Isometric view’ might be used, when relevant. 

Creating a slice section of results 

Section slicing of the model to create graphs of results is to be done with the model 

lying orthogonal to the screen.  

  Press the Home button to ensure that the model is viewed correctly. 

 Ensure the Snap to grid button is selected 

and a grid size of 10 is specified. 

 Click the OK button. 

 

 

 

 

 

 

 

 

 

 Click and drag the 

cursor as shown (at the 

X=40 location) to 

define a section slice 

through the handle of 

the spanner where it 

joins the jaws. 

The loadcase and extent of 

the slice must now be defined: 



Utilities 

Graph Through 2D... 

 

Drag to here

Click here
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 Ensure that Loadcase 1 and an extent of Visible model are selected, and Click 

the Next button. 

This leads directly on to creating a graph using the graph wizard: 

Selecting the slice data results to be plotted 

In this example a graph is to be plotted of the variation in stress through the specified 

section of the spanner. The X axis results of distance through the spanner have been 

defined by the section slice. The Y axis results now need to be specified. 

 On the Slice data dialog, ensure 

Stress - contour results from the 

Entity drop down list, and 

equivalent stresses SE from the 

Component list are selected. 

 Click the Next button to define 

the Y axis results.  

 

 

 

 

Title information for the graph is now to be added: 

 Enter the graph title as 

Stress at neck section 

 Enter the X axis label as 

Distance along section 

 Enter the Y axis label as 

Equivalent Stress 

(N/mm2) 

 Deselect the Show 

symbols button. 

 Click the Finish button 

to display the graph in a 

new window and show 

the values used in an 

adjacent table.  
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Note. If the graph title or axes labels are left unspecified Modeller will use default 

names.  

 

Note. The properties of the graph may be modified by clicking on the graph with the 

right-hand mouse button and selecting the Edit Graph Properties option. 

 Close the graph window, and return the view window. 

 To exit from the Graph Through 2D option click the Select Any cursor button. 

The grid will be removed. 

 

This completes the example. 

 

 

 

 

 

 

 

 


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